How Can | Best Enjoy
Music and Videos in

ITunes?
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You can start playing music and videos within minutes of launching iTunes,
but to get the very best out of iTunes, you'll need to explore its advanced fea-
tures. Do you want to make sure that iTunes gives you the highest audio
quality that your Mac can deliver — and that you get the best possible sound
on your iPod as well? What about building an iTunes library that lets you
quickly find the songs you like? You'll probably want to create both unchang-
ing playlists and playlists that update themselves automatically with fresh
songs, back up your iTunes library in case disaster strikes your Mac, and use

your iPod to carry or transfer essential files as well as your songs and videos.
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Getting High-Quality Audio on iTunes
and an iPod

If you love music, you'll love the audio quality that iTunes and an iPod can deliver.But to get the very
best out of your Mac and iPod, you need to choose the right settings in iTunes and on the iPod.

Setting iTunes to deliver high audio quality

You need to do three things to set iTunes to give you high-quality audio:

@ SetiTunes to create high-quality audio files from CD
@ Choose essential playback settings in iTunes

@ Apply equalizations to your songs

Setting iTunes to create high-quality audio files from CD

Here’s how to get the best audio quality when you import songs from CD.

1. Choose iTunes > Preferences to open the Preferences dialog box.

2. Click General in the toolbar to open the General preferences (see figure 1.1).
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1.1 iTunes’ General preferences let you control which action iTunes takes when you insert a CD.
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Tell iTunes what to do when you put a CD in your Mac. | find that Show CD is the best

choice because it lets you fix any incorrect tag information before you import the CD.Your
alternatives are Begin Playing, Ask To Import CD (the default), Import CD, Import CD And
Eject,and Show CD.

Select the Automatically retrieve CD track names from Internet check box if you want
iTunes to download track names for you. This is the easiest way to get CD information,
but it's a good idea to check that the information is correct before you apply it.

Click the Import Settings button to display the Import Settings dialog box (see figure 1.2).

Import Settings

Import Using: | AAC Encoder J :l
Setting: | Higher Quality (256 kbps) =
Details

128 kbps (mono)/256 kbps (stereo), optimized
for MMX/SSE2.

"1 Use error correction when reading Audio CDs

Use this option if you experience problems with the
audio quality from Audio CDs. This may reduce the
speed of importing.

MNote: These settings do not apply to songs
downloaded from the iTunes Store.

iTunes’ Import Settings control the quality of the music you get in iTunes

on your iMac and on your iPod or iPhone. If you want high-quality audio, you
need to change the default settings.

In the Import Using pop-up menu, choose the encoder for creating the audio files. See
the sidebar “Picking the Best Encoding for Your Needs" for advice.

Choose a quality setting for the encoder in the Setting pop-up menu. iTunes offers pre-
set choices for all encoders except Apple Lossless Encoding.To choose custom settings, click
Custom and work in the dialog box that iTunes displays. Figure 1.3 shows the MP3 Encoder
dialog box for choosing custom settings for encoding MP3 files.

Select the Use error correction when reading Audio CDs check box if you find your
song files contain pops, skips, or dropouts caused by the drive reading them incor-
rectly, or if you simply want to be sure of getting quality audio files. Using error correc-
tion slows down the importing speed, so you may prefer to clear this check box and test
whether the song files come out clean.

Click OK to close the Import Settings dialog box, and then click OK to close the
Preferences dialog box.



MP3 Encoder

Stereo Bit Rate: [ 320 kbps |—:'i

E Use Variable Bit Rate Encoding (VBR)
Quality: [ Highest FH

(With VBR enabled, bit rate settings are used for a guaranteed minimum bit rate.)

Sample Rate: | Auto F':"q
Channels: [ Auto I—:—i
Stereo Mode: | Normal I—:—i

E Smart Encoding Adjustments

E Filter Frequencies Below 10 Hz

(" Use Default Settings\_ (" cancel ) ( oK )

1.3 Custom dialog boxes such as the MP3 Encoder dialog box let you choose exactly
the encoding settings you want.

Choosing essential playback settings in iTunes
Your next step is to choose three settings that make a huge difference to how iTunes plays back
the songs. Follow these steps:

1. Choose iTunes > Preferences to open the Preferences dialog box.
2. Click the Playback button to display the Playback preferences (see figure 1.4).

3. Select the Crossfade Playback check box only if you want to use the cross-fading fea-
ture. This fades from the end of one song to the beginning of the next. If you use this fea-
ture, drag the slider to set the number of seconds (from 1 to 12), depending on how much of
each song you want to lose.

4. Select the Sound Enhancer check box if you want to use Sound Enhancer. This feature
performs several audio tricks, such as increasing the stereo separation of the left and right
tracks and adding harmonics. Sound Enhancer can make music sound more lively, but at the
cost of authenticity. If you use this feature, drag the slider to set the degree of enhancement.

5. Select the Sound Check check box if you want iTunes to normalize your songs.
Normalization involves evaluating the songs in your library for loud and quiet points and
reducing the difference between the two.This helps to avoid getting your ears blasted by a
loud song that follows a quiet one, but it makes the music much less dynamic and compelling.



ever used a Loudness button on an old stereo, you may see a similarity between that
and Sound Enhancer. But where most Loudness features could only be either on or
off, you can adjust the amount of difference the Sound Enhancer makes by dragging
its slider.

6. Click OK to close the Preferences dialog box. Test the settings you've chosen by playing
various types of songs,and change the settings if you don't like the results.
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1.4 In the Playback preferences, choose whether to crossfade playback, use
Sound Enhancer, and use Sound Check.

=y

I It Punch to penetrate our cluttered consciousness on the radio or in public, sound

as the sound engineer has given them. Unfortunately, to pack songs with enough

engineers all too often now compress the dynamic range, which makes the music

seem louder overall but removes the difference between the “loud”and “quiet” parts.



CDs contain music files in an uncompressed format designed for use on CDs. To copy the
songs from CDs to your Mac, you use an encoder to convert the files to a format suitable for
computers. iTunes comes with five encoders, so you can pick the one that's right for your
needs. For some of these encoders, you can also adjust the quality setting, or bitrate, which
also affects the file size.

iTunes comes set to import songs from CD using the Advanced Audio Coding (AAC)
encoder at the 128 Kbps bitrate. This is good for general-purpose recording with modest
file sizes, but if you want high audio quality, either choose the Higher Quality (256 Kbps)
setting, or use the Custom dialog box to set the highest available bitrate, 320 Kbps.

If you use a Mac and an iPod or iPhone, AAC is usually the best format to choose. iTunes,
iPods, and iPhones can play AAC files, but most other hardware and software players
can't. If you need to play your song files on other players, use the MP3 format instead.
MP3 has lower quality than AAC at the same bitrate, so choose at least the Higher
Quality (192 Kbps) bitrate for MP3. For best results, use the Custom dialog box to set the
highest available bitrate, 320 Kbps.

If you have lots of hard disk space on your Mac and want superior audio quality, try the
Apple Lossless Encoding encoder. Lossless means that, unlike the AAC and MP3
encoders, Apple Lossless Encoding does not discard any of the data contained in the
original music — so the song file should be perfect. Apple Lossless Encoding files take up
much more space than AAC and MP3 files, so they're not great for iPods and the iPhone.
In fact, the iPod shuffle can't even play Apple Lossless Encoding files.

Your last two choices of encoder are WAV and AIFF. These are essentially the same thing:

uncompressed audio data, but with different instructions at the beginning of the file. WAV
and AIFF both give perfect audio quality but lack the tag information that portable music
players need; besides, WAV and AIFF files are so large that few will fit on any but the
most capacious portable players.

Applying an equalization to the music you're playing

Your third move toward making songs sound the way you like them is to use the Equalizer. You can
either apply an equalization to the music as you listen, just as you might do with a graphical equalizer
on a stereo or boom-box, or apply an equalization to any song in your library (see the next section).



iTunes’' Equalizer is easy to use.These are the moves you need to know:

@ Choose Window > Equalizer or press 88+Option+2 to toggle the display of the Equalizer

(see figure 1.5).

e0o Equalizer

1.5 Use the Equalizer to make songs sound the way you like them.

@ Select the On check box to turn the

Equalizer on,and then choose the equal-
ization you want from the pop-up menu.

To create a custom equalization, drag
the frequency sliders to produce the
sound you want. If you want to boost
the amplification, drag the Preamp slider
up; to reduce the amplification, drag the
slider down.Open the pop-up menu,
choose Make Preset, type the name in
the Make Preset dialog box (see figure
1.6),and then click OK.

To rename or delete an equalization,
open the pop-up menu and choose Edit
Presets. In the Edit Presets dialog box
(see figure 1.7), select the equalization,
and then click Rename (to rename it) or
Delete (to delete it). Click Done when
you're ready to close the dialog box.
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1.6 You can easily create a custom preset to
apply an equalization.
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1.7 Use the Edit Presets dialog to rename a pre-
set or delete it.
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|' JI ustom equalizations don't carry t

these devices, it's best to experiment with iTunes’ built-in equalizations before creat-

Note | lale] /eltieo1ar

Applying an equalization to a particular song

Applying an equalization as you're listening works well, but what's much handier is applying an
equalization to each song in your library. This way, whenever you play the song, iTunes uses that
equalization automatically. So does your iPod or iPhone (as long as the equalization you choose is
one of the built-in ones).

You can apply an equalization to any song in your library in one of these ways:

@ single song. Ctrl+click or right-click the song, choose Get Info, and then click the
Options tab of the Item Info dialog box (see figure 1.8). Open the Equalizer Preset pop-up

menu, choose the equalization, and then click OK.
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1.8 Choosing an equalization for a single song in the Item Info dialog box.

@ Single song. Add the Equalizer column to the current view by Ctrl+clicking or right-
clicking an empty column heading (after the last column) and choosing Equalizer from
the menu.(You can also replace an existing column by Ctrl+clicking or right-clicking its
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column heading and then choosing Equalizer.) You can then apply an equalization to a

song by using the pop-up menu as shown in figure 1.9.
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1.9 Add the Equalizer column to a view to give yourself the easiest way to
apply an equalization to a song.

© Multiple songs, an album, or all an artist’s songs. Select the songs or the album,
Ctrl+click or right-click, and choose Get Info to open the Multiple Item Information dia-
log box. For an artist, click the artist,and then press 8+ to open the Multiple Item
Information dialog box. Click the Options tab, open the Equalizer Preset pop-up menu,
choose the equalization, and then click OK.

to, the type of speakers or headphones you use, and the state of your ears, not to

mention your personal preferences. Bear in mind that the names of the built-in

Genius

equalizations are merely suggestions — so if you find you like to listen to speed

metal using the Jazz equalization, feel free to do so.

Choosing suitable iPod settings

To get the highest audio quality on your iPod, you need to load high-quality songs, such as those
you've ripped from your CDs as discussed earlier in this chapter. You need to turn off the Sound
Check feature on your iPod (or iPhone) to prevent it from normalizing the sound. You may also
need to apply equalizations on the iPod.

11



ILire"09 Portable Genius

audio quality by buying higher-quality headphones that you find comfortable. If

you're thinking of upgrading your headphones, also look into buying a headphone
amplifier because this can greatly improve the sound you get out of your iPod or
iPhone.

Turning off Sound Check on the iPod or iPhone
If you want songs to sound good on your iPod or iPhone, turn off the Sound Check feature to pre-
vent the player from robbing the songs of dynamic range by normalizing the sound.

Here’s how to turn off Sound Check on the various models of iPod and on the iPhone:

@ Sixth-generation iPod or iPod nano. Choose Main menu = Settings = Sound Check,
and then press the Select button to switch between On and Off.

@ iPod shuffle. Connect the iPod shuffle to your Mac, then click it in the Devices category
in the Source list to display its control screens. On the Settings tab, clear the Enable
Sound Check check box, and then click Apply.

@ iPod touch. Press Home, touch Settings, touch Music, and then touch the Sound Check
slider to move it to the On position or the Off position.

@ iPhone. Press Home, touch Settings, touch iPod, and then touch the Sound Check slider
to move it to the On position or the Off position.

Applying equalizations on the iPod or iPhone
If you've applied one of iTunes’built-in equalizations to each song, as discussed earlier in this chap-
ter, your iPod or iPhone automatically applies those equalizations when you listen to the songs.

To keep audio quality high on the iPod shuffle, clear the Convert higher bit rate songs to
128 Kbps AAC check box in the Options area of the iPod’s Settings tab. Converting
songs to 128 Kbps AAC reduces the amount of space the songs take up, but it costs you
audio quality. You lose even more quality if the song you're converting was encoded

using an encoder other than AAC (for example, MP3). The conversion also makes syn-

chronization take longer, which is seldom welcome.

12



When you've applied a custom equalization to a song, however, you'll find that it's not available on

your iPod. In this case, you can change the equalization on the iPod or iPhone manually. You may
also need to do this for songs whose equalizations are available, simply because songs sound dif-
ferently through headphones than through your Mac’s sound system.

Here's how to apply an equalization on the iPod or iPhone:

@ Sixth-generation iPod or iPod nano. Choose Main menu = Settings = EQ. Scroll to the
equalization you want, and then press the Select button.

@ iPod touch. Press Home, touch Settings, touch Music, and then touch EQ.On the EQ
screen, touch the equalization you want, and then touch Music to return to the Music
screen.

@ iPhone. Press Home, touch Settings, touch iPod, and then touch EQ.On the EQ screen,
touch the equalization you want, and then touch iPod to return to the iPod screen.

Building a Powerful, Easy-to-Use
Library

To make your iTunes library as powerful and easy-to-use as possible, store it in a folder that has
plenty of space, and make sure that folder contains the file for each song in the library. For faster
searching and enjoyable playlists, tag the files with accurate information, rate the songs so that
iTunes knows which you like, and trim off any unwanted parts of songs.

Normally, you'll want to store all your songs in a single library so that you can play them easily. But
if need be, you can create multiple iTunes libraries, each containing a different collection of songs.

Choosing where to store your library

iTunes normally comes set to handle your library like this:

®

Put all your music and video files in the same folder within your Home folder.

®

Keep the folder organized by artist folder, album folder, track number, and track title —
for example, /Bruce Springsteen/Greatest Hits/01 Born to Run.m4a. (If there’s a disk num-
ber, such as Disk 1 of 2, iTunes includes that too.)

© Make a copy of each file you add to the library from another folder, instead of linking to
the file in that folder.
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This behavior is convenient for many people, but if you have a large iTunes library or your Mac has a
small hard disk, you may run short of space.You may also want to store your iTunes library in a differ-
ent folder so that you (or others) can access the media files from other computers on your network.

Here’s how to check and change where iTunes is storing your library and choose other key settings.

1. ChooseiTunes => Preferences and then click the Advanced button to display the
Advanced preferences (see figure 1.10).

Advanced

Do BE u [ B w

GCeneral Playback Sharing Store  Parental Apple TV Devices | Advanced

iTunes Music folder location

[ Change... |
\ Reset )

Macintosh HD:Users:guy:Music:iTunes:iTunes Music:

a Keep iTunes Music folder organized
Places files into album and artist folders, and names the files based on
the disc number, track number, and the song title.

aCopv files to iTunes Music folder when adding to library

Streaming Buffer Size: ['Medium B:

Use iTunes for Internet playback: [ Set |

Reset all dialog warnings: [ Reset |

a Keep MiniPlayer on top of all other windows
a Keep movie window on top of all other windows
| Display visualizer full screen

Eﬂroup compilations when browsing

[ Cancel ) @

1.10 Use the Advanced preferences to choose where to store your library.

2. Look at the iTunes Music folder location box to see which folder iTunes is storing your
music in. If you want to change the folder, click the Change button, select the new folder in
the Change Music Folder Location dialog box, and then click Open.

3. Select the Keep iTunes Music folder organized check box if you want iTunes to organ-
ize the folder and filenames. This setting is usually helpful, but it does mean that when

you change a tag such as a song name, iTunes changes the filename to match as well.
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4. Select the Copy files to iTunes Music folder when adding to library check box if you

want iTunes to copy each file you add from another folder. If you want iTunes to create a

link to the file in that folder instead, clear this check box.

5. Click OK to close the Preferences dialog box.

Getting all your media files in the same folder

If you want to be able to back up your iTunes library in a single action, use the Consolidate Library

command to make sure all your media files are stored in the same folder.

e ] Plenty of space to hold all the files. The easiest way to see how much space your

iTunes library takes up is to click the Music item in the Source list, click All in the
Artists list and the Album list, and then look at the readout at the bottom of the
iTunes window. Repeat the process for Movies, TV Shows, and any other items that

appear in the Source list,and then add the figures together.

When you give this command, iTunes copies any files that are stored outside your iTunes Music

folder into the iTunes Music folder.Normally, it’s a good idea to select the Keep iTunes Music folder

organized check box in the Advanced preferences before you consolidate your library, allowing

iTunes to rename folders and files and generally keep your library straight.

After this preparation, consolidating your library is easy, but copying the files may take some time.

Follow these steps:

1. ChooseFile => Library ©> Consolidate
Library. iTunes displays the message
box shown in figure 1.11.

2. Click Consolidate. iTunes copies those
files that are located outside your iTunes
Music folder into the folder. If you've
selected the Keep iTunes Music folder
organized check box, iTunes renames
files whose names differ from their tag
information.

- Consolidating your library will copy all of your music Inte
{ . the iTunes Music folder.

This cannot be undone.

(o) (Carmoiie)

1.11 iTunes double-checks that you want to
consolidate your iTunes library because there’s
no easy way to undo a consolidation.
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Tagging songs after adding them to your library

After you've added a song to your library, you can easily change its existing tags or add missing tag
information.

If you need to change a tag that’s displayed in whichever iTunes view you're using, you can simply
edititin place like this.

1. Click once to select the song.

2. After a short pause, click again to put an edit box around the field (see figure 1.12). If
you don't pause between the clicks, iTunes registers a double-click and starts playing the

song.

s Don't You {Forget Abo... 421 Simple Minds Qittering Prize 111372005 &:57 AM
[ Leilani 203 Came Theory Tinker to Evers to Chance 11/2/2005 9:04 PM

i Creeping Death Apocalyptica Piays Metallica By Four Cellos 117162005 4:50 PM

@ Too Little Too Late Metric i} 771872006 3:53 PM

s Cadlilac Comling James Ray 11572006 12:37 PM

1.12 The quickest way to edit a single tag is to open an edit box in the iTunes list.

3. Click to position the insertion point, type the change, and then press Return to apply
the change.

. /] Genre pop-up menu and choose Custom, or simply drag across whichever genre is
N currently displayed to select the text.Type the name of the genre you want to create.
You'll then be able to use this genre for other songs too.

To change several tags on a single song, use the Item Information dialog box like this:

1. Ctrl+click or right-click the song and choose Get Info to open the Item Information
dialog box.

2. Click the tab that contains the tags or settings you want to change. For example, to con-
trol how iTunes sorts the songs, click the Sorting tab (see figure 1.13) and use the boxes on it.

Select the Gapless Album check box if you want to mark the songs as being gapless.

This setting turns off cross-fading and is good for live albums, classical music, and

spoken-word audio.
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[ Summary Info Video | Sorting = Options  Lyrics  Artwork |

Name Sort Name

Fortune Teller

Artist Sort Artist

Robert Plant and Alison Krauss Robert Plant I
Album Artist Sort Album Artist

Robert Plant and Alison Krauss

Album Sort Album

Raising Sand

Composer Sort Composer

Show Sort Show

(Previous) ( Next ) @ @

1.13 The Sorting tab of the Item Information dialog box lets you add extra information
for sorting without changing the tags that appear in the iTunes interface.

3. When you finish changing the tags and settings, click OK.

Understanding the less obvious tags
Most of the tag fields, such as Name and Artist, are easy to grasp. Here’s a quick run-down of the

more puzzling ones:

@ Album Artist. The artist name that you want to use for the album, where it’s different
from the artist name for the song. For example, you might use Various Artists as the

album artist for a compilation album.

®

Grouping. This tag lets you group the movements in a classical music work, but you can
use it for other purposes too. For example, instead of creating a Psychedelic Rock genre,
use the Rock genre and put Psychedelic in the Grouping tag; or add Grouping tags such
as Party or Workout to songs of different genres so that you can pick them out across dif-

ferent genres.

@ BPM.Beats per minute — the tempo of the song.
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To find out the beats per minute of songs and add this info to the tags, use a too

such as Tangerine from Potion Factory (www.potionfactory.com/tangerine/) or

beaTunes (www.beatunes.com).

@ Sort tags (Sort Name, Sort Artist, Sort Album Artist, Sort Album, Sort Composer, and
Sort Show). These let you control how iTunes sorts songs (and shows) without changing
the information iTunes displays. For example, you may want to sort your Beethoven
music by “Beethoven”rather than by the names of the various orchestras and conduc-
tors. By adding Beethoven to the Sort Artist tag, you can do so.

To change one or more tags on multiple songs at once, use the Multiple Item Information dialog
box like this:

1. Select the songs whose tags you want to change. For example, click the first song, then
88+click each of the other songs.

2. Ctrl+click or right-click in the selection and choose Get Info to open the Multiple Item
Information dialog box (see figure 1.14).

Viitls e nformat

: Info . Video Sorting Options 1
Artist Year
O | #2007 |
Album Artist Track Number
O O s 0 —
Album Disc Number
| 01 Jof 01
Grouping BPM
O 0
Composer Artwork
|
=
O
|
Genre Mng
[ Alternative & Punk B # xxxx

1.14 Use the Multiple Item Information dialog box to change shared tag

information on several songs at once.
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3. Change the tags that apply to all the songs you selected, and then click OK. When you

change a tag, iTunes selects the check box next to it so that you can easily track the changes
you've made.

-

to the Artwork box on the Info tab in the Multiple Item Information dialog box.

Note Amazon.com includes cover pictures for many CDs, but you can also add your own

pictures if you prefer.

If you want to apply tags to your songs automatically, visit the Doug’s AppleScripts

for iTunes Web site (http://dougscripts.com/itunes/) and look through the Managing

Track Info scripts.

Trimming off unwanted parts of songs

Do you ever find yourself always skipping the beginning or end of a song? If so, don't suffer

through it — use this trick to trim off the unwanted part of the song.

. Play the song, and note the time at which you want the song to start or stop.

. Ctrl+click or right-click the song and choose Get Info to open the Item Information
dialog box, and then click the Options tab (see figure 1.15).

. Click in the Start Time box or the Stop Time box, and then type the time you want the
song to start or stop. Use the format minutes:seconds.thousandths — for example, 3:24.000.
Note that it’s a period between the seconds and thousandths, not a second colon.

. Click OK to close the dialog box.

. Play the song again and make sure the cutoff is right. If not, open the Item Information
dialog box again and adjust it.

. Right-click the song and choose Create Format Version. (Format here is the encoding for-
mat you've chosen in iTunes — for example, Create AAC Version.) iTunes creates a new ver-
sion of the file minus the parts you chose to exclude.

. If you want, remove the original song file from your iTunes library, leaving the new
file.
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| summary Info Video Sorting | Options = Lyrics Artwork |

Vel ﬁla‘u b 9

"
-100% None +100%

Equalizer Preset: [ Psychedelic ﬁ

Raig:

[ Start Time: 0:00
" Stop Time: 2:24.784

" Remember playback position
[~ Skip when shuffling
1 Part of a gapless album

(oo (Rt o

1.15 On the Options tab of the Item Information dialog box, you can set the
start time or end time for a song. You can then trim the song file to use this

start time or end time.

can be useful when you've recorded a live performance and want to keep only parts
of it. First, create a duplicate copy of the song. The easiest way to do this is to
Ctrl+click or right-click the song, choose Show In Finder, press 8+D to duplicate the
song file,and then drag the duplicate to your iTunes library.In iTunes, trim off the first

Genius

part of the song from one file, leaving the second part, and then trim off the second

part of the song from the other file, leaving the first part.

Separating your music with multiple iTunes
libraries

Normally, iTunes puts all your songs into a single library. But here’s a neat feature: You can create
separate music libraries if you want. For example, you may prefer to keep your classical music sep-
arate from your popular music, put a library on an external drive to save space on your Mac’s hard
drive, or maintain a family-friendly library as well as one that includes harder-edged material.
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Creating a new iTunes library |

one:

1. QuitiTunes if it's running. Press 8+Q

. . Choose iTunes Library
First, create a new library. Here’s how to create { 1'
o

or choose iTunes > Quit iTunes.

2. Hold down Option and click the
iTunes icon on the Dock to display
the Choose iTunes Library dialog box

unes needs a library To continue, You may choose an existing Tunes.
library or create a new one.

it ) (" Create Library... ) ( Choose Library... )

1.16 The Choose iTunes Library dialog box is
your springboard for both creating and selecting
separate iTunes libraries.

(see figure 1.16). Keep holding down Option until the dialog box appears — a quick
Option+click doesn't usually do the trick.

3. Click the Create Library button to display the New iTunes Library dialog box (see

figure 1.17).

O™ New iTunes Library

Save As: | Chill-Out Music

=

(«]»]) (22 =|m] [E@iTunes

B (@ search

» DEVICES | [ Audio Hijack
= CarageBand
¥ SHARED .
H 100, o [ iTunes

[ Album Artwork Lo
[:I Heavy Metal Music P
[ iPod Games [

El i iTunes 4 M.__brary copy
— iTunes Library
i [ Tunes Music Lo
¥ PLACES =| iTunes Mu...ry copy.xmil
[T Documents =| iTunes Music Library.xmil
E Desktop D Previous i...s Libraries
71}! Applicati...
&Y quy I 1
| TMusic
[ New Folder (" Ccancel ) ( Save )

1.17 Give your new iTunes library a descriptive name so that you can easily identify it.

4. Type a descriptive name for the library (for example, Chill-Out Music) in place of

iTunes’ suggestion (iTunes 1,iTunes 2, and so on), choose the folder in which to store
the library, and then click the Save button.

5. iTunes opens using the library you just created, so no songs appear in it. You can now

add songs to the library as usual:

Insert a CD and rip its songs to audio files.
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Drag audio files from a Finder window to the library.

Choose File => Import, select the folder containing the files, and then click Open.

After you've added songs to the library, you can use the library as normal. For example, you can
play songs back, add them to playlists, or create Smart Playlists that draw on the library.

ences. By default, this is the ~/Music/iTunes/ folder unless you change it. If you've got
plenty of hard disk space, this folder is a good choice. But if you want to put the new

library in another folder, expand the New iTunes Library dialog box and navigate to
that folder.

Selecting the library you want to load
To switch from one library to another, you use the Choose iTunes Library dialog box you saw a
moment ago.

1. QuitiTunes if it’s running. Press 88+Q or choose iTunes = Quit iTunes.

2. Hold down Option and click the iTunes icon on the Dock to display the Choose iTunes
Library dialog box. Keep holding down Option until the dialog box appears.

3. Click the Choose Library button to display the Open iTunes Library dialog box.

4. Select the library you want, and then click the Open button.

When you want to switch to another library, simply quit iTunes, and then hold down Option
as you restart it.

If you open iTunes without holding down Option, iTunes opens the last library you

used.

Enjoying Music and Visualizations
with iTunes

As soon as you've got a good selection of songs in iTunes, you can relax and enjoy them —
together with iTunes’ stunning visualizations if you like.
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iTunes could hardly be simpler to control with the mouse, but you can also control it using the key-

board — even when iTunes isn't the active window.

When iTunes has the focus (is the active application), you can control it using the keyboard short-
cuts shown inTable 1.1.(If iTunes doesn’t have the focus, the quickest way of switching the focus to
iTunes is to hold down & and press Tab until the iTunes icon is selected, then release 88.)

Table 1.1 Keyboard Shortcuts for Controlling iTunes

Play/pause
Next song

Previous song

Spacebar
Right Arrow or 8+Right Arrow

Left Arrow or 38-+Left Arrow

Rewind 88+Option+Left Arrow
Fast forward 88 +Option+Right Arrow
Next album in the current list Option+Right Arrow
Previous album in the current list Option-+Left Arrow
Increase the volume 8+Up Arrow

Decrease the volume

38+Down Arrow

Mute or unmute iTunes Option-+Left Arrow
Display or hide iTunes main window 88+Option+1
Display or hide Graphical Equalizer 88+Option+2
Zoom to or from mini player 8+Ctrl+Z
Minimize iTunes 8+M

Select the Find box 88+Option+F

Turn the Visualizer on or off 84T

Switch the Visualizer to or from full-screen mode 8+F

Sharing Music

Enjoying music on your own is great, but even better is sharing the music you like with other peo-
ple — and letting them share music with you.

iTunes lets you share music in two different ways. First, you can share all or part of your library with
other iTunes users on your local network, and they can share with you. Second, you can share a
playlist with the whole wired world by publishing it to the iTunes Store.
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The Visualizer is great, but you can make it even better by using the following secret key

presses to adjust the behaviors, color schemes, and color themes:

© Press W to start the next behavior, or Q to revert to the previous behavior.

© Press A to change to the next color scheme, or press S to go back to the previ-
ous scheme. The color scheme is a set of colors within the color theme (see the
next paragraph).

© Press Z to switch to the next color theme, or X to switch back to the previous
theme. The color theme is the overall mix of colors, so pressing these keys pro-
duces a bigger difference than changing the color scheme.

When you find a Visualizer configuration you like, save it by pressing a key combination
from Shift+0 to Shift+9 (which lets you save ten different configurations). Press the num-
ber without Shift to launch that configuration.

Press R to switch to a random configuration, or press D to reset the Visualizer to its
defaults.

Press F to toggle the frame rate display on and off, T to toggle frame-rate capping at 30
frames per second, and | to toggle the display of song information on and off.

iTunes lets your Mac share music with five other computers per day. Any
puters see a message saying that your Mac is not accepting sharing or that it accepts
only five different users each day, so please try again later.

Sharing music on the network

Your first step for sharing music is to share it with other iTunes users on your local network. Sharing
works with iTunes on both Macs and PCs.

Setting iTunes to share music and look for shared music
You can set up sharing and looking for music others are sharing in a single step:

1. Choose iTunes => Preferences to open the iTunes Preferences dialog box.

2. Click the Sharing button to display the Sharing preferences (see figure 1.18).
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] @ B e L L B o

Ceneral Playback Sharing Store  Parental Apple TV Dewvices  Advanced

a Look for shared libraries
aShare my library on my local network

() Share entire library
8 Share selected playlists:

[T Car Playlist 1 4
E{ Female Vocal Favorites m
[T Garbage Playlist

M Kills Playlist

[ Leonard Cohen

[ Limbo ¥

a Require password: sssssssss

Status: Off

[ Cancel ) @

1.18 Setting up sharing and looking for shared music in iTunes’ Sharing preferences.

3. Select the Look for shared libraries check box if you want iTunes to show the songs
other people are sharing.

4. Select the Share my library on my local network check box if you want to share some
or all of your songs. iTunes enables the controls beneath this check box so that you can
choose which songs to share:

To share all your songs, select the Share entire library option button.To share only a
selection of songs, select the Share selected playlists option button, and then select the
check box for each playlist you want to share.

If you want to protect your shared songs with a password, select the Require password
check box and type the password in the box next to it. A password is useful on a larger net-
work where you need to stay within iTunes'five-computers-a-day limit for sharing.On a
smaller network (for example, at home), a password may be a hindrance rather than a help.

5. Click the General button to display the General preferences, and then type the name
you want to give your shared library in the Library Name box. This is the name under
which your shared songs appear in the Source list on other people’s computers.

6. Click OK. iTunes closes the dialog box and starts sharing the songs you chose.
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Changing the selection of
playlists you're sharing

If you chose to share some playlists rather
than share all your music, you can quickly
share another playlist or stop sharing a playlist
you're sharing. Ctrl+click or right-click the
playlist in the Source list (see figure 1.19), and
then click Share to either remove the check
mark next to it (if the playlist was shared) or to
place a check mark next to it (if the playlist
wasn'’t shared).

Playing songs that other iTunes users are

sharing

Once you've selected the Look for shared libraries check box (as dis-
cussed earlier in this chapter), iTunes automatically displays the library
names in the Shared category of the Source list (see figure 1.20). If the
Shared category has a sideways disclosure triangle next to it, click the

triangle to display the shared libraries.

Click a library to display its contents in your current iTunes window, or
double-click it to display its contents in a new window.

If the library is password-protected, iTunes displays the Shared Library
Password dialog box (see figure 1.21). Type the password, select the
Remember password check box if you want iTunes to remember it so
you don't have to type it again, and then click OK.

After you connect to a shared library, you can find and play music using

|1'| Acte Power ]
|1'| Adrenalin Rug
rﬂ Current Favo
[ iPod Manual
|1‘| Tempoarary Pl
|1‘| Woice Mem oz
|1‘| Z_Current List Delete

+ (% | 2 p=

1.19 The quick way to share or stop sharing a
playlist is to Ctrl+click or right-click it and choose
Share from the menu.

Open
Edit Smart Playlist

Export Song List...
Burn Playlist to Disc

Copy To Play Order

9 Applications
¢ Fadio
L. Fingtones

STORE
7 iTunes Stare
[& Puchased
VSHARED
R iMac's Shared Songs ()
% Progressive Bile
I sonos Elise Likes Today
TPLAYLE TS
=) Party Shuffle
S cerius

1.20 Libraries others
are sharing appear in
the Shared category of
the Source list.

the same techniques as for your own library. For example:

@ Click the disclosure triangle next to the
library to toggle the display of its
playlists on or off.If you display the
playlists, you can click a playlist to show
only its contents, as in figure 1.22.
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Shared Library Password

The shared library “Progressive Bile” requires a
password:

“Q Password:[-o-oou-l ]

¥ Remember password

{_ Cancel @

1.21 Connecting to a shared iTunes library that’s
protected by a password.
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1.22 Browsing a single playlist in a shared library.

@ Choose View = Show Browser to display the browser so that you can browse by artist or
album.

@ Search for songs using the Search box.

Sort the shared songs or playlists into a different order by clicking the column headings.

q

Clear the check box of any song you don’t want to play.

q

However, because of copyright restrictions, you can’t copy songs to your Mac, add them to
playlists, or burn them to CD or DVD.

When you finish using a library, disconnect from it by clicking the Eject button next to its name in
the Source list.
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Sharing an iMix playlist on the iTunes Store

When you create a great playlist, you may want to share it more widely than people on your local
network.To put the playlist in reach of every iTunes user on the planet, publish it as an iMix on the
iTunes Store.

enius that are available on the iTunes Store. This limitation makes sure that anybody who

list and order of songs rather than the song files themselves, you can include only songs

downloads your iMix can listen to all the songs, so it's reasonable enough —and iTunes
warns you when songs you've included in your playlist will be removed from the iMix.

When you've created a playlist that you want to make into an iMix:

1. Inthe Source list, click the playlist.

2. Choose Store = Create An iMix. Unless you're already signed in to the iTunes Store, iTunes
displays the Sign In To Publish Your iMix dialog box.

3. Signin as usual using your Apple ID or your AOL screen name and password, and then
click the Publish button. iTunes displays the iMixes screen, showing which songs from your
playlist are available for the iMix. Figure 1.23 shows an example.

Adrenalin Rush

A high-voltage set for a quick workout or run -- enjoy|

Time | Antist | Abum | Price
Freak Magnet L7 Hungry for Stink $0.99 ((EUCSONG
The Age of the Undersatement The Las ShadowP...  The Age of the Und... $0.99 |_sur sone
Mo Wow The Kills hlo W 40,90 iy sonc
Kiss Kiss Hedly Valance What a Girl ¥ants $0.99 (_EUY SOKC
Brerywhers With Helicoprer Guided By Voices Thie Best of Guided ... 40,90 _suy sonc
Danger High Voltage {Kilagram R... Blectric Six Dange High Valta. .. $0.90 [ mir wns

1.23 Set up your playlist as either a regular iMix or a Sport iMix, give it a
catchy title, and provide a description.
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4. Check through the songs left in the iMix after the iTunes Store has removed those that

aren’t available. If the iMix won't work in its reduced form, click Cancel, return to iTunes,
and then fix it.

5. If the iMix is best for sports, click the Sport iMix option button instead of the iMix
option button.

6. Change the title for the iMix in the Title box if necessary. You may want to give the iMix a
more explicit and descriptive name on the iTunes Store than your playlist needed on your
Mac.

7. Type a description for the iMix in the Description box. This is optional, but a good
description helps draw listeners to your iMix.

8. Click Publish. iTunes displays the iMix Received screen to let you know that it has pub-
lished the iMix to the iTunes Store.

9. Click Done. If you want to see your iMix on the iTunes Store, wait until you receive the e-mail
message telling you that the iMix has been posted, and then click the link in the message.

=

Note

The iTunes Store keeps each iMix for a year before removing it automatically.

Playing music through AirTunes

If you have an AirPort Express wireless access point, you can plug your speakers into it and play
music through them from iTunes. You can send the music from any computer running iTunes —
Windows PCs as well as Macs — either across the wireless network or via a wired Ethernet network.

To play music across a wired network, you need to turn on the AirTunes over Ethernet feature like this:

1. Click the Desktop, choose Go > Utilities, and then double-click AirPort Utility to open
AirPort Utility.

2. Click the AirPort Express in the list box, and then click Manual Setup to reach the con-
figuration screen.

3. Click the Music button in the toolbar.
4. Select the Enable AirTunes over Ethernet check box.

5. If you want to restrict use of the speakers to people who know a password, type the
password in the iTunes Speaker Password box and the Verify Password box.
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6. Click Update.

7. Press 38+Q or choose AirPort Utility = Quit AirPort Utility.

To start playing the music through AirPort

Express, click the Speakers pop-up menu but- + Computer
AirPort Express 01

ton in the lower right corner of the iTunes win-

dow, and then choose the AirPort Express Multiple Speakers. ..

from the menu. The Speakers pop-up menu
button (see figure 1.24) appears only when

iTunes detects an AirPort Express within strik-

ing distance. 1.24 Use the Speakers pop-up menu to switch
between your computer’s speakers and speakers
connected to an AirPort Express.

through AirPort Express and speakers connected to your Mac at the same time.To do

Il this, click the Speakers pop-up menu in iTunes, and then click Multiple Speakers. The
Remote Speakers dialog box opens.Select the check box next to each set of speakers
you want to play music through, and then click Close.

akers pop-up menu
Express is available, choose iTunes = Preferences, and then click the Devices button

Q )

Note to display the Devices preferences. Select the Look for remote speakers connected

with AirTunes check box to make iTunes look for the AirPort Express. While you're

here, you can also select the Disable iTunes volume control for remote speakers

check box if you want to prevent iTunes from controlling the volume on the speak-
ers,and select the Allow iTunes control from remote speakers if you want the remote
speakers to be able to control iTunes. Click OK when you've made your choices.

Making Videos That Work with iTunes

To enjoy iTunes as fully as possible, you'll want to use it to watch videos too.You can buy movies, TV
shows, and music videos from the iTunes Store, but most likely you'll want to create your own
videos as well.
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Creating videos from iMovie

If you've created your own movies in iMovie, you can easily export versions that you can play in

iTunes or on an iPod. Follow these steps:

1. Launch iMovie, and then open the movie you want to export.

2. Choose Share = iTunes to open the Publish your project to iTunes sheet (see figure 1.25).

Publish your project to iTunes
Choose sizes based on where you will view your movies.

2 8 v =

iPod iPhone sty Computer

Sizes: [ | Tiny . 176x144 ©
M Mobile ® O 480x272
W Medium . . . 640x360
M Large [ ] 960x540

C Cancel ) M

1.25 iMovie makes it easy to create versions of your movies that will play in iTunes, on the iPod or
iPhone, or on Apple TV.

3. Select the check box for each size you want to create. The blue dots show which of the
four devices — iPod, iPhone, Apple TV, and Computer — the sizes are suitable for.
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Even though it plays on the iPhone, the Tiny size looks poor on almost any device.

Not The Mobile size gives far better results, but the file size is five times as large.
ote

4. Click Publish.iMovie exports the version or versions you chose, adds it or them to iTunes,
and activates iTunes.

5. IniTunes, click the Movies category in the Source pane, and then test the movies you
created.

Note

See Chapters 4, 5,and 6 for detailed coverage of iMovie.

Creating videos from DVDs

Another tempting possibility is to create videos from your DVDs.That way, you can play the videos
from iTunes without needing the DVD, enjoy them on an iPod or iPhone during your commute, or
connect the iPod or iPhone to a TV via a cable and share them with your friends.

For legal reasons, Apple doesn't provide tools for creating videos from DVDs. Instead, you need to
use a third-party application such as HandBrake (http://handbrake.fr). After ripping files from the
DVD, drag the files to your iTunes library to add them to it.

Making the Most of Playlists

Listening to an entire album at a time is easy enough, but often you'll want to make your own
arrangements of songs.iTunes lets you create unchanging playlists, in which you choose the songs
and their order, and Smart Playlists, in which iTunes chooses the songs and their order for you.

Creating unchanging playlists

Sometimes you'll want to create playlists that contain only the songs you choose, in exactly the
order you prefer them.For example, you might create a playlist for working out or running, with dif-
ferent tempos and rhythms to drive on your efforts; or you might create a chill-out playlist.
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If you have an Apple TV, you can connect it to your wired or wireless network so that you
can play back content from iTunes on your TV's screen and speakers.

First, pair your Apple TV with iTunes like this:
1. Turn on your TV and the Apple TV.

2. On your Mac, double-click the Source list in iTunes to expand it

(if it's collapsed), and then click Apple TV. iTunes prompts you for the

passcode for the Apple TV.

3. Type the passcode that appears on the TV screen into iTunes, and
you'll be in business.

Now that the Apple TV is paired with iTunes, you can browse your iTunes library and
your iPhoto library from the Apple TV. Select the content you want to play back — for
example, a TV show from iTunes or a slideshow from iPhoto — and set it playing.

Here’s how to create an unchanging playlist like this:

1. Start a new playlist in one of these ways: + (%= 3 ]
Click the Create a Playlist button (the + button) in the lower

1.26 You can starta

playlist by clicking the

Choose File ©> New Playlist or press 88+N. Create a Playlist button.

left corner of the iTunes window (see figure 1.26).

Select the first few songs you want to add to the playlist,and
then either drag them to open space at the bottom of the Source list or choose File =>
New Playlist from Selection. Alternatively, press 38+Shift+N.

2. Inthe edit box that iTunes displays, type the name you want to give the playlist, and
press Return.

3. Drag songs to the playlist. You can also drag an entire album, an artist, or an existing
playlist to the new playlist.

4. Click the playlist to display its contents, then drag the songs into the order you want.
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Creating Smart playlists

Unchanging playlists are easy and fun, but what'’s often even better is having iTunes build Smart

Playlists for you — playlists that iTunes fills with songs matching the criteria you set.You can either

keep the iTunes' initial selection of songs or let iTunes update a Smart Playlist automatically with

new songs you add to your library.

Here’s how to create a Smart Playlist. The example produces a playlist of favorite songs from the

years 2000 to 2005 drawn from the Rock genres, and excluding any song that’s marked as being in

a compilation album.

Set up the first condition for the playlist.

. Choose File => New Smart Playlist or Option+click the Create ETEAANCE
Playlist button in the lower left corner of the iTunes window
(see figure 1.27). iTunes opens the Smart Playlist dialog box. 1.27 Option+click the

Create Playlist button
to start creating a new
Smart Playlist.

Open the first pop-up menu and choose the field you want to use for the first condi-
tion. For the example, choose Year.Figure 1.28 shows the choices that become available
when you do this.

. 1 |

™ Match the following rule:
e (is I%] 2008 ]O®
[Limitto 25 itemns B selected by | random =
"] Match only checked items
E Live updating
o)

1.28 Setting up the first condition for the example playlist.
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Open the second pop-up menu and make a suitable choice from the list. Your
choices here depend on the field you selected in the first pop-up menu.In the example,

iy nuy nuy

you can choose from “is,"“is not,”“is greater than,"”"is less than,”and “is in the range”;
choose“is in the range.”The first line of the Smart Playlist dialog box changes to provide

two boxes so that you can enter the range of years.



In the third control or set of con- [ S

W match the Fallowing rule:

trols, enter the details of the condi-

[Year %] [z in the range o) 2o | o [zons iG]
tion. In this example, enter the years Dt o (35— (T8 st b (o =
2000 and 2005, giving the condition Faai A
“Year is in the range 2000 to 2005” CCaneel ) (0K )

(see figure 1.29). 1.29 When you make a choice, the Smart Playlist

3. If necessary, click the Add button at dialog box changes as necessary to show the
the right end of the first line of con- relevant options.

trols to add a second line, and then

choose settings for the second condition. These are the settings you would choose to cre-

ate the example playlist:
Open the first pop-up menu and choose Genre.

In the second pop-up menu, leave the default selection — Contains — selected
because this is what you need.

In the text box, type rock. If iTunes automatically suggests Rock as you type, press the
Right Arrow key to accept the suggestion.

4. If necessary, add further conditions. The example playlist needs two more conditions (see
figure 1.30):

Rating is in the range ®% & ¥ to ®& &% (four stars to five stars).

Compilation is false.

Smart Playlist
M Match [all 5] of the following rules:
['Year %] lisintherange 3] [2000 to 2005 = ®
| Genre %] [ contains %] Rock ’:\ &:
| Rating :?] I'is in the range B dkkk - to ko e @
[€ ilati Iéi I'is false 3] e ':-B

[Limitto 25 items 'C] selected by | random

[T Match only checked items

ar

E' Live updating

Cancel ) @

1.30 The Smart Playlist with all its four conditions in place.

5. If you want to limit the playlist to a certain length or number of songs, select the Limit
to check box and specify the limit.
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Type the number in the first box, and then choose Minutes, Hours, MB, GB, or Items

in the first pop-up menu.

In the second pop-up menu, choose how to select the songs — for example, by least
often played, by highest rating, or simply at random.

6. Select the Match only checked items check box if you want to include only songs
whose check boxes you've selected. This setting lets you clear a song’s check box and be
sure it won't show up in your Smart Playlists.

7. Select the Live updating check box if you want iTunes to update the Smart Playlist for
you automatically.

8. Click OK to close the Smart Playlist dialog box. iTunes creates the playlist, gives it a
default name (such as Rock), and displays an edit box around the name.

9. Type the name you want to give the Smart Playlist, then press Enter.

iTunes automatically adds each playlist to the Playlists category in the Source list, putting
the Smart Playlists (with their distinctive cog icon) first in alphabetical order and then the

regular playlists, also in alphabetical order.

When you've created more than a handful of playlists, you may find the Source list growing
awkwardly long. To cut it down to size, you can create playlist folders and put your playlists
in them. If you want, you can create a whole structure of playlist folders and subfolders.

To create a playlist folder, choose File &= New Folder or press 8+Option+Shift+N. Type
the name for the folder in the edit box that iTunes displays around the default name (“unti-

tled folder”) and press Return.

To create a subfolder, just click the existing folder first before giving the New Folder com-

mand.

When your folder is ready, drag a playlist to move it to the folder. Within the folders,

iTunes sorts the Smart Playlists first, and then the playlists, both in alphabetical order.

To rename a playlist folder, double-click its name to display an edit box. Type the new
name and press Return.

To delete a playlist folder, Ctrl+click or rightclick it and click Delete.

To create a new playlist or Smart Playlist within a folder, click that folder, and then give
the New Playlist command or New Smart Playlist command.
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Creating Genius playlists

When you want to create a Smart Playlist quickly, you can use iTunes’ Genius feature.The Genius is

essentially a pre-configured Smart Playlist that analyzes the song you pick as a starting point and

chooses a set of related songs.

Using the Genius could hardly be simpler:

1. Inyour library, or in a playlist, select the song on which you want to base the Genius

playlist.

2. Click the Start Genius button in the
lower-right corner of the iTunes win-
dow (see figure 1.31) or the Genius
symbol in the iTunes track readout at
the top of the window.

i AjrPort Express 01 4

Burn Disc

Start Genius.

1.31 Click the Start Genius button to create a

playlist based on the current song.

3. iTunes creates the Genius playlist (see figure 1.32) and starts it playing. Adjust the

playlist as needed:
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1.32 You can quickly change the number of songs in the Genius playlist or refresh it with new songs.
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To change the number of songs, open the Limit to pop-up menu and choose a different
number: 25 songs, 50 songs, 75 songs, or 100 songs.

To refresh the playlist but keep it based on the same song, click the Refresh button.

To base the playlist on a song in the playlist, click that song, and then click the Start
Genius button.

To save the playlist, click the Save Playlist button.iTunes saves the playlist under the
name of the first song.To change the name, double-click it in the Source list, type the
new name, and then press Return.

Burning Discs and Backing Up Your
Library

When you've created a playlist, you can burn it to a CD so that you can play it on just about any CD
player in the world.You can also create a higher-capacity MP3 CD that will play on MP3 CD players
and computers.

iTunes also lets you burn a DVD containing a playlist or a series of DVDs containing a backup of
your full library.

Burning a playlist to CD

Here's how to burn a playlist to disc:

1. In the Source list, click the playlist you want to burn to CD.

l' Jl iITunes gives the CD the same name as the playlist, so it you want to give the CD a

ferent name, rename the playlist before burning the CD.You can restore the playlist’s

N[ -B original name after the burn if you want.

2. Click the Burn Disc button that appears toward the lower right corner of the iTunes
window. iTunes displays the Burn Settings dialog box (see figure 1.33).

3. Choose the burning speed in the Preferred Speed pop-up menu. Usually, it'’s best to
choose Maximum Possible to let iTunes use the burner’s fastest speed; but if you find the
discs you burn contain errors, try throttling back the speed.
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CD Burner: OPTIARC DVD RW AD-5630A

Preferred Speed: ["Maximum Possible H

Disc Format: ) Audio CD

Gap Between Songs: | 2 seconds B

Tl Use Sound Check
[linclude CD Text
O MP3CD

() Data CD or DVD

Data discs include all files in the playlist. These
discs may not play in some players.

(Gonee) om0

1.33 iTunes’Burn Settings dialog box lets you tell iTunes which type of CD
you want to create.

in the Burn Settings dialog box to choose which drive to use. If your Mac has a single

PPNl burnerdrive (as most Macs do), CD Burner appears as a readout rather than a pop-up

menu.

4. Select the option button for the type of disc you want to create:

Audio CD. This is the type of CD you can play in any CD player, from a basic boom-box to
a top-of-the-line deck. An audio CD can contain up to around 80 minutes of audio.The
audio is uncompressed, so it’s full quality.

MP3 CD. This is a CD that contains only MP3 files — you can't include other types of
audio files (such as AAC or Apple Lossless Encoding files). The amount of music an MP3
CD can contain depends on the MP3 bitrate, but you can get up to about 11 hours at
decent quality (128 Kbps) or fewer hours at higher quality. MP3 CDs play only in MP3 CD
players and computers, not regular CD players.

Data CD or DVD. This is a computer CD or DVD that happens to contain only audio files.
You use this type of disc for backup or file transfer. Data CDs or DVDs play only on com-
puters, not in regular CD players or in most regular DVD players.

5. If you chose to create an audio CD, choose the next three options:
In the Gap Between Songs pop-up menu, choose the number of seconds for iTunes to
put between songs: Either choose None, or a number of seconds between 1 second and

5 seconds. A gap of 2 seconds or so helps when you're ripping the CD with iTunes or
another audio program.
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Select the Sound Check check box only if you want to even out the volume across the
CD.The advantage of this normalization is that you don't get a CD with some songs far
quieter than others.The disadvantage is that normalization compresses the dynamic
range of the songs, which makes them sound less dramatic and can make the CD seem
monotonous.

Select the Include CD Text check box to put CD text — artist and song information — on
the CD.Some CD players (especially car CD players) can display CD text, which is handy
for keeping track of what you're listening to.

6. Click Burn to close the Burn Settings dialog box.

7. When iTunes prompts you to insert a blank disc, do so. iTunes then burns the playlist to
the disc.

8. Eject the disc and label it.

check that the burn was successful. If you burned an audio CD, test it either in your

Mac or any CD player.If you burned an MP3 CD, use your Mac or an MP3 CD-capable

CD player.If you burned a data CD or DVD, use your Mac or another computer.

only seven times. Once you hit this limit, you can create another playlist and burn
(YTl that one up to seven times. The replacement playlist can contain the same songs in

the same order as the original, so this limitation is only an inconvenience.

Burning a playlist to DVD for backup or file
transfer

iTunes can also burn a playlist to DVD as long as your Mac has a DVD burner drive. DVDs are great
for backing up your library or for transferring files from your Mac to another computer. You can't
play music from audio DVDs in most non-computer DVD players.

Here's how to burn a DVD:

1. Click the playlist in the Source pane, and then click the Burn Disc button.

2. Choose the Data CD or DVD option button in the Burn Settings dialog box.

40



3. Insert a disc when iTunes prompts
you to do so, and then C“Ck the Data @ You have inserted a blank DVD. Are you sure you wish
[ K DvD?

. tocreate a data

Data DVDs are only usable in computers with a DVD drive. Burning a
DVD may take as long as an hour.

DVD button in the confirmation dia-

log box that appears (see figure 1.34). ) D)
4. If the playlist you've chosen is too 1.34 iTunes double-checks that you want to
long to fit on the DVD, iTunes warns Create a data DVD.

you (see figure 1.35). Click the Cancel

button if you want to slim down the
p|ay|ist unt" |t f|ts on the DVD C||ck the @ The items in this playlist will not fit on one data disc.

- Do you want to create multiple data discs with this
playlist split across them?

Data Discs button if you don’t mind

This will require mare than one blank disc 1o complete.

® (Concel ) (Coatabises)

breaking the playlist among two or
more DVDs.

1.35 iTunes warns you if the playlist won't fit on

5. When the burn is complete, eject the )
the DVD you've provided.

disc and label it. Then put it back in
your Mac and make sure its contents are
all present and correct.

If you've chosen a low-capacity, single-layer DVD by mistake, cancel the burn so that
you can eject the disc and substitute a higher-capacity, dual-layer DVD.

If you cancel a burn, the disc stays in your Mac, but it appears in neither the Devices list
in iTunes nor in the Sidebar in the Finder. To eject the disc, use Disk Utility like this:

1. Click the Desktop or the Finder icon on the Dock, and then
choose Go = Utilities to open a Finder window showing the
Utilities folder.

2. Double-click Disk Utility to open Disk Utility.

3. In the left box, click the entry for the DVD drive, and then click
the Eject button on the toolbar.

. Choose Disk Utility = Quit Disk Utility to quit Disk Utility.
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Another way of sharing a playlist is to export it from one computer and import it on
another. When you export a playlist, iTunes simply creates a list of the songs in the
playlist— it doesn’t include the song files themselves. Then when you import the playlist
on another computer, iTunes adds to it only the songs that are available on that computer.

These restrictions mean that exporting and importing playlists work best when you're
using the same library. For example, if you put the same set of songs on your MacBook
and your iMac, you can export a playlist from the iMac and use it on the MacBook with-
out problems.

Here's how to export a playlist:

1. Click the playlist in the Source list.
2. Choose File = Library & Export to open the Save dialog box.

3. Change the playlist’s name if necessary, and select the folder in

which to save the file.

. Choose XML in the Format pop-up menu. XML is the best choice when
you're sharing a playlist with another computer running iTunes. The other for-
mats — Plain Text and Unicode — are useful for exporting playlists to applica-

tions that can’t read XML.
5. Click Save.

To import a playlist, choose File = Import, select the playlist in the Import dialog box, and then
click Open. If the playlist contains songs that your library doesn’t have, iTunes warns you.

Restoring your music library from backup

After restoring your music library by inserting your first backup disc in your Mac’s optical drive and
following the prompts, you may need to delete extra copies of playlists. iTunes puts the playlists
from each backup into a separate folder named Restored Playlists and the date (in YYYY-MM-DD
format) and time (in HH:MM:SS format), so you end up with folders named like this:

@ Restored Playlists 2008-12-11 11:12:44

@ Restored Playlists 2008-12-11 11:20:53
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Check that the latest playlists are the ones you want, and then delete the rest. (If you delete the
wrong ones, no great worry — you can restore them again from your backups if necessary.)

your iPod as a backup. Unless you lose (or damage) both your iPod and your Mac at
the same time, you can restore your library to your Mac from the copy your iPod con-

tains. But you can't use iTunes to restore your library from your iPod. Instead, you

need to use third-party software such as iPod Access (www.ipodaccess.com), iPodRip
(www.thelittleappfactory.com), or Senuti (www.fadingred.org/senuti) to restore the
library from the iPod to your Mac.

Using Your iPod to Carry Files

Your iPod is great for playing back music and (except for the iPod shuffle) video, but you can also
use it to carry files with you.This is handy both for keeping your essential documents with you and
for transferring large files from one computer to another.

Here’s how to set up your iPod for carrying files:

1. Connect your iPod to your Mac. If iTunes isn't already running, Mac OS X launches it. Your
iPod appears in the Devices category in the Source list,and iTunes displays the control
screens for the iPod.

2. Click the Summary tab (for an iPod classic or iPod nano) or the Settings tab (for an
iPod shuffle). Figure 1.36 shows the Summary tab for an iPod classic.

3. Select the Enable disk use check box. iTunes displays a dialog box warning you that you
need to eject the iPod manually (see figure 1.37).

4. Select the Do not warn me again check box, and then click OK. The dialog box closes.

5. Click Apply. iTunes turns on disk mode for the iPod and synchronizes the iPod.
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1.36 To use your iPod to carry files, select the Enable disk use check box on the Summary tab or
Settings tab.

e ——

Enabling the iPod for disk use requires manually ejecting
the iPod before each disconnect, even when automatically
syncing music.

" Do not warn me again

( Cancel ) G—GK—)

1.37 Tell iTunes you're prepared to eject your iPod manually before you
disconnect it.

Your iPod now appears as a drive in the Finder (see figure 1.38),and you can store files and folders
on it as you would any other removable drive.
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1.38 Creating a folder on the iPod in a Finder window.

When'you display the iPod’s contents in a Finder window, you'll see several folders,
such as Calendars, Contacts, and Notes. You won't see your songs and videos, which
are hidden in an invisible folder named iPod_Control. Don't store your files in one of
the iPod’s folders. Instead, create one or more folders of your own.

After you enable disk mode on your iPod, you must eject it before you disconnect it. To eject the
iPod, click the Eject button next to its item in the Source list in iTunes or in the Sidebar of a Finder

window.

Ifyou'have aniPodtouch or an'iPhone rather than one of the smalleriPods, you can't

=

[Tl 2s DiskAid (www.digidna.net/diskaid) or PhoneView that lets you put files on an iPod

use this technique to store and move files. Instead, look at third-party software such

touch or iPhone.
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